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Module One  

 
Introduction to web page creation using Macromedia Dreamweaver 
 
This tutorial will cover the following components: 
 

1. What is Dreamweaver? 
2. What is HTML? 
3. What is the difference between the printed page and a web 

page? 
4. Images and links 
5. Compatibility issues. 
6. Web page layout 
7. Download times 

 
 
 What is Dreamweaver? 
 

 
Keywords 

 
WYSIWYG 
What You See Is 
What You Get – a 
graphical user 
interface (GUI) 
 
HTML 
Hyper Text Mark-up 
Language – also 
Source - the code 
behind the page 
 
FTP 
File Transfer 
Protocol – 
transferring web files 
between computers 
 
Source 
Another name for 
HTML code, but 
normally used to 
describe the code of 
a page already 
online. 

Dreamweaver is a WYSIWYG web 
development program. It simplifies the more routine 
tasks of web development such as insertion of META 
information. One of its features is its on-board FTP 
client, allowing you to publish your pages from within 
the programme itself. 
 
For anyone contributing content to a corporate website, 
Dreamweaver makes the most common tasks simple. 
For those who have previous experience of using 
HTML to construct their pages, Dreamweaver will 
simplify some of the more routine tasks. 
 
The following pages and exercises will enable you to 
use Dreamweaver for the first time, allowing you to 
develop your web pages with ease. 
 

 
What is HTML?  

HTML isn't a programming language, it's a 
mark-up or scripting language and all it does is tell your 
web browser how to render or display your page. A web 
page script is composed of two components - the actual 
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content of the page and the HTML describing how it should appear. Every 
element that is in a Web page is marked up (hence the M in HTML) using HTML 
tags. It is these tags that tell your web browser how to render the page. 

For example, a section of bold text in a web page will be surrounded by bold 
tags, and will look like this:  

<b>This is a sentence in bold text.</b>  

In most cases, HTML tags come in pairs - an opening tag (<*>) and a closing 
tag (</*>). As you can see, the closing tag looks like the opening tag, except 
that it contains a forward slash. (The asterisks indicate where the variable tag 
letter would be.) There are of course exceptions to this rule, but more about that 
later. 

An HTML script must also conform to a specific structure. Scripts have two 
sections: the head, which contains hidden elements of a page, including its title 
(the text that appears in the top bar in the browser window, next to Microsoft 
Internet Explorer, for example), and the body which contains the contents of the 
page that you can see in the browser. The head and body of the page are also 
defined by opening and closing HTML tags to show where those sections begin 
and end. So, now you can create your first, simple page:  
<html> 
<head> 
<title>My Home Page</title> 
</head> 
<body> 
<strong>Content Heading</strong> 
<p>Text and Images </p> 
</body> 
</html> 
 
Don’t panic! If you haven’t even looked at HTML code before, you’ll feel much 
better in about 30 minutes! 

Exercise One 

Launch Notepad and type this script exactly as it appears into the text editor, 
then save it as index.html. Launch your browser and then locate the file and 
open it (File > Open > Browse). You will see a web page entitled My Home 
Page containing some bold text and some normal text.  

All the elements that we discussed before are present in this script. There are a 
pair of head tags that contain a title for the page between the <title> </title> 
tags, and a body section with the content, formatted using simple HTML tags. 
You might notice a couple of other things about the script above. The first is that 
the whole script is contained within or nested between the tags <html> </html>. 
This tells your browser that it's dealing with an HTML script.  

 
Mini-Glossary (This is not an exhaustive list of tags) 
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<html> </html> - These tags are used tell your Web browser to treat the script 
as an HTML file. Most Web browsers do this by default, but it's still good 
practice to include them.  

<head> </head> - These define the head section of the document. All the script 
within these tags is invisible when viewed in a browser (apart from the page 
title. An exception!). This is also where certain JavaScript elements will go as 
well as any META tags, but more on these later. 

<title> </title> - where the title of the page is placed.  

<body> </body> - Defines the body section of the document, which contains 
the main content of the page.  

<strong> </strong> - Makes text appear bold.  

<i> </i> - makes text appear in italics 
Exercise Two 
 

• Launch Microsoft’s Internet Explorer 
• In the Address Bar type in www.kcl.ac.uk This will take you to the King’s 

College home page 
• Click on View > Source – the source code of the 

page will open in notepad. Have a look at this to 
see which bits you can recognise. It’s a good 
idea to have some familiarity with HTML for the 
purposes of tweaking certain browser 
incompatibilities or for inserting special elements 
such as JavaScript or Server Side Includes. 
(More on these later.) 

 
Exercise Three 
 
Now download the page and analyse it in 
Dreamweaver. 
 

• Using the same browser and home page, click 
on File > Save As and in the Save As File Type 
select Web Page, Complete. The page will then 
be saved, with its graphics and any other 
relevant files, onto your hard disk. It should 
comprise one HTML document and a folder. 

• Browse to the saved HTML document on your 
hard disk and right click on it, choosing Edit 
With Dreamweaver.  

• Dreamweaver will automatically launch and the 
page that you downloaded will open. You can then anal
check out the HTML using the split or code view. This 
want to find out or understand how a particular page wa
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• Spend some time looking at the HTML code to see how
identify. (See additional sheet) 

 
 

Keywords 
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• In the Code View, try changing some of the tags to see what effects they 

have on the page. Click on the Preview button  or choose File > 
Preview in Browser and select the browser to use. 

 
Exercise Four 
 
Open Notepad and type the following code: 
 
<html> 
<head> Keywords 

 
Graphic 
Either an image 
created using a 
drawing programme 
such as Macromedia 
Fireworks or a 
photographic image. 
 
Interactive 
For the purposes of 
basic web design, this 
mean when a web 
page component 
changes due to the 
intervention of the 
visitor. 
 
File Size 
The size of a file, 
measured in bytes or 
kilobytes. If the file 
measures in 
megabytes it’s way too 
big! 
 
Resolution 
The setting that 
determines the amount 
of information that 
appears on your 
screen, measured in 
pixels. Low resolution, 
such as 800x600 
makes items on the 
screen appear large 
although the screen 
area is small. High 
resolution, such as 
1600x1200 makes the 
overall screen area 
large, although 
individual items appear 
small. 

<title>Table Document</title> 
<meta http-equiv="Content-Type" content="text/html; 
charset=iso-8859-1"> 
</head> 
<body bgcolor="#FFFFFF" text="#000000"> 
<table width="500" border="0" cellspacing="0" 
cellpadding="0"> 
  <tr> 
    <td>&nbsp;</td> 
    <td>&nbsp;</td> 
  </tr> 
  <tr> 
    <td>&nbsp;</td> 
    <td>&nbsp;</td> 
  </tr> 
</table> 
</body> 
</html> 
 
Preview this page in your browser. What you should see 
is a small table with two rows and two columns. 
 

 
What is the difference between the
printed page and a web page? 

 
 
 

 
Until the advent of the Internet and the World 

Wide Web, information was routinely disseminated using 
the printed word. This continues today of course, but 
more and more information is also (or alternatively) 
published via the web. Unlike printed words and pictures, 
a web page can also display moving images and sound 
as well as other numerous interactive components. It is 
worth noting here that the flexibility of the printed page is 
far greater than that of a web page.  
 
There are some basic principles to bear in mind when 
regarding web pages. 
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Once printed, a hard copy of a document will appear the same, wherever it is 
viewed. Web pages on the other hand can appear differently, depending on 
what type of computer is being used, which browser (and which version of 
browser) and the resolution and quality of the computer monitor. A printed 
document is navigated by turning the page and using the contents or index, 
whereas web pages are navigated using hyper-links. One of the most 
important differences between the two is the way in which the pages are read or 
viewed. Whilst the printed word tends to be read line by line, until the end of the 
text has been reached, the viewer scans web pages in a quite random fashion, 
until the relevant information has been found. The attention span of the web 
page visitor is also dramatically reduced. If the information cannot be found 
within ten seconds or so, it is likely that the visitor will move on to another page 
or site. 
 
The expectations of web pages are also radically different to that of print. Books 
and magazines are bought or borrowed in the almost certain knowledge that 
they will contain the information required. This is not really the case with web 
pages as there is no guarantee that the web page that has been found will in 
fact contain anything of relevance. 

 
If the page is in fact appropriate, then the viewer will 
want as many links as possible to related information. 
This may be facilitated by body text links, a menu of 
links or links attached to graphics or photo images. 
 
 
Images and Links 
 

As previously indicated, links are used to 
navigate through a body of information, whether it be a 
single page or an entire site. This is the most important 
component of any website. Without an effective 
navigation tool visitors to your site will soon become 
frustrated and move onto another site. These links are 
normally facilitated via text links, but depending on the 
style of a particular site, graphical images may also be 
used. An obvious example of this is a button or 
graphical text banner to facilitate a link. This can either 
be a static graphic or an interactive graphic that 
changes its look when activated by a mouse hover. The 
most common form of interactive button is the rollover, 
where the button has an up (normal), over (where the 
mouse pointer hovers over the button and down (where 
the button is pressed to select) state. Photographic 
images can also be used as links either to other areas 
on the page or web site or to a larger version of the 
same image (the smaller image is known as a 
thumbnail). 
 
Note: Of course, photographs can be used in their own 

right but care should be taken if you are not to increase the file size of the page 
as a whole, making it very slow to download. It is worth remembering that most 

Keywords 
 
Pixels 
Short for picture 
element, it is one spot 
in a grid of thousands, 
that form part of an 
image produced on a 
computer screen. A 
pixel is the smallest 
element that software 
or hardware can 
manipulate to create 
graphical elements. 
 
Monitor 
Like television 
screens, a monitor 
displays pictures and 
information. Computer 
monitors are of a much 
higher quality than 
TVs. 
 
Platform 
Otherwise know as the 
Operating System 
 
Browser 
The generic term for a 
software programme 
that ‘renders’ or 
translates HTML code 
into a graphic format. 
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people do not have fast Internet access. If, because of a high-resolution 
photograph, a page takes more than 10-15 seconds to download, most visitors 
will move on without waiting. 
 

 
Compatibility Issues  

 
 

In order for your pages to be accessed by your audience, there are a 
number of fundamentals that you need to be aware of. The main consideration 
is that all these factors are partly controlled by the visitor to your site, not you. 
 

Page Size 
 

One of the most important aspects of basic web page design is page 
size. How do you get all your information on the page? Well, it’s worth 
remembering that this isn’t a standard A4 sheet of paper. You will need 
to consider the different sizes of monitor that the 
web page is to be viewed on together with the 
screen resolution. A 15” or 17” monitor with a high 
resolution will display more of a page than those 
set at a lower resolution. 

 
The object of this is to avoid vertical and/or 
horizontal scroll bars appearing on the browser. 
Under normal circumstances, vertical scroll bars 
are acceptable only if they do not make the user 
have to continuously scroll down the page to find 
the information they want. In these cases consider 
using a type of link called an anchor (more on this 
later). Horizontal scroll bars are never advisable. 
With so many variables, a balance needs to be 
achieved so that you get your information to your 
audience with the minimum amount of fuss. 
Experience shows that it is advisable to set the 
page width at no more than 740 pixels. The page 
height can be set at 500 pixels to begin with. If all 
the information that you need to display cannot be 
reasonably fitted within this area, then extra, 
continuation pages should be added. It is much 
more user friendly to manage the information in 
this manner than to just have one very long page. 

 
 

Monitor Size 
 

The size, specification and affordability of 
computer monitors have changed considerably 
over the last few years. Where once a 14” monitor was accepted as 
entry level when buying a computer, it is now far more common to be 
offered a 17” model. Serious users such as web professionals and 
designers will usually opt for a 19” or 22” monitor. Designing for a 17” 

Keywords 
 

Download 
Retrieving 
information from 
another computer or 
website. 
 
Load 
The process of the 
browser rendering or 
displaying a web 
page. 
 
Modem 
The hardware that 
enables you to 
connect to the 
Internet. 
 
Kps 
KiloPackets per 
second – the rate at 
which data is 
transferred via a 
modem. The higher 
the figure, the faster 
the transfer rate. 
 
ISDN 
Integrated Services 
Digital Networks – a 
fast type of digital 
network connection 
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monitor with a resolution of 800x600 pixels is now acceptable as the 
average user configuration and thus a page width of 740 pixels will easily 
fit on the majority of monitors. (The 60 pixel difference between 800 
pixels and 740 pixels takes account of the window and its components. 
Thus 740 is the actual visible area of the web page.) 
 

 
Cross Platform Issues 

 
Cross Platform is the term used to describe the compatibility of web 
pages between Microsoft Windows and Macintosh OS. Lately, other 
operating platforms, such at Linux have begun to gain popularity and 
whilst they are far from common, serious web designers should give 
them some consideration. You should view or test your pages on a Mac 
as well as a PC – and vice versa. 
 
 

Cross Browser Issues 
 

There are a number of browsers available for the purpose of viewing 
web sites - Microsoft’s Internet Explorer (App. 1), the Colleges 
preferred browser, Netscape’s Navigator (App. 2) and Opera (App.3). 
Also, when viewed on a Mac, Internet Explorer (App. 4) and Netscape 
(App. 5) all of which are free to download and use. Each browser 
actually looks quite similar, but there are significant differences in the 
way they render pages. The King’s website looks exactly the same in 
each browser and this is no accident!  
  

 
Browser Version Issues. 

 
Not only are there different monitors, different operating systems and 
different browsers, there are also different versions of each browser – 
and they all render web pages slightly – and sometimes dramatically – 
differently. All these variables need to be considered by web designers 
when developing their pages. 

 
The answer to all this is to test your pages on as many of these 
variations as you can. Alternatively, ask you colleagues or friends to 
check your pages on their computers. 
 

 
 Web Page Layout 
 
 

Before starting to create a page using tables you are advised to plan 
it on paper first. This gives you a much better idea of what goes where and also 
saves some considerable time later on. The creation and use of tables is 
covered in the next module. Tables can be used to present data and to produce 
more controlled and complex page layouts. They are the basis of almost all 
effective web page layouts. Each cell of the table can be used to hold page 
content (text or images, for example) accurately in place.  
 
 

7



 
 
 
 

 
The maximum number of visitors will view a successful web site and its 

component pages if the pages download in an acceptably quick time. Nearly 
everyone who has access to the Internet from their home will use a modem to 
do so. Your modem will access the Internet at a particular connection rate or 
speed. This speed will vary from 14,000 kps to 56,000 kps, depending on the 
type of modem that you have. Many people have ISDN access, which is much 
faster at around 64,000 kps or even 128,000 kps. Other people will have 
broadband access at 500,000 kps. Accessing the Internet from your workplace 
means that it will be even faster than broadband speed. The college network 
provides a speed of 100,000 kps. So, just because it appears instantaneously 
on your desktop machine doesn’t mean it will on a typical home PC or Mac. 
 
For the purposes of web development, we have to accommodate the average 
user and this means developing pages for a typical 28,800 kps modem. 
Dreamweaver gives you an ongoing indicator of the download time of your 
page. The default is set at 28,8000 kps, but this can be changed to suit 
individual requirements. The trick is to keep your pages down to around 10 – 15 
seconds for a maximum download time – less if you can manage it. Just keep 
your eye on that indicator at the bottom of your Dreamweaver window (Fig. 1). 
 
 
 

 
 
 

Download Times 

Fig. 1 
 

 
In this tutorial you have learned about : 
 
 
 

1. What is Dreamweaver? 
2. What is HTML? 
3. What is the difference between the printed page and a web 

page? 
4. Images and links 
5. Compatibility issues. 
6. Web page layout 
7. Download times 
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APPENDICES 
 
 
 
Appendix. 1 - Microsoft Internet Explorer 
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Appendix. 2 – Netscape 
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Appendix. 3 – Opera 
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Appendix 4. Internet Explorer on a Mac 
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Appendix 5. Netscape on a Mac 
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Appendix 6. Opera on a Mac 
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